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INTRODUZIONE.

In questo documento viene presentata una guida generale per un corretto utilizzo della scheda ai fini
del caricamento, sulla DE1, del gioco sviluppato e del’utilizzo di quest’ultimo.
Il manuale comprende:
e una spiegazione dei collegamenti fisici, come i connettori per la porta VGA e la tastiera
PS/2;
e una spiegazione del caricamento, del gioco creato, sulla board;
e una breve spiegazione su eventuali correzioni ed impostazioni facoltative come ad
esempio la modifica del tipo di frutta;
e ed infine la spiegazione del gioco vero e proprio con le relative istruzioni sui pulsanti o

push-buttons da utilizzare.

STRUMENTAZIONE.

- Board altera cyclone 11 FPGA Starter (0 successive)

- Computer dotato di ingresso vga, I/O analogici per I’audio, porta ush, porta ps/2
- Cavo VGA

- Cavo jack 3.5mm

- Cavo usb blaster in dotazione con la board

- Monitor VGA

- Tastiera PS/2

- Casse audio



COLLEGAMENTI HARDWARE

1. Collegare mediante cavo USB BLASTER la board DE1 al PC.

2. Collegare mediante cavo VGA la board DE1 al monitor VGA.

3. Collegare, mediante cavo jack 3.5mm, la board DE1 alle casse audio.




4. Collegare la tastiera PS/2 tramite 1’apposito connettore.
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A questo punto é possibile accendere tutti i dispositivi.

CARICAMENTO AUDIO.

Nota:

Per il caricamento audio viene utilizzato il tool software proprietario dell’altera che permette la
comunicazione via usb con la memoria flash della DE1, dandoci cosi modo di i scrivere dati dal
nostro terminale.

Tutto I’occorrente per effettuare tale passaggio viene fornito nella cartella chiamata “tool”
all’interno del CD consegnato.

Il software citato si chiama “CII_Starter_Kit_Control_Panel” ed utilizza unicamente 1’interfaccia
contenuta nel progetto Quartus dell’altera denominato “CII_Starter USB_API.pof™.

E importante assicurarsi che all’interno della board sia precaricato tale progetto altrimenti durante il

gioco non sara presente 1’audio (sul monitor viene visualizzata la schermata riportata in figura).
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In caso contrario visionare il capitolo “CARICAMENTO SOFTWARE” relativo al caricamento

seriale per progetti con estensione .pof.
A questo punto, effettuata la verifica appena descritta, i passaggi da seguire per il caricamento del

file audio sono i seguenti:

1. Eseguire CIl_Starter_Kit_Control_Panel.exe e cliccare suL tab FLASH (Figura 1).
2. Cliccare su Open - Open USB Port 0 (Figura 1).

Open | Help About

Open USB Port 0
: R s

LASH
~Random Access

Address : I[] wDATA lg[] IDATA Igg

Chip Erase (40 Sec) | \Write | Read I

—Sequential Write

Address Iu Length: lu ™ File Length

YWrite a File to FLASH

—Sequential Read
Address : |[] Length : I[] [” Entire Flash

Load FLASH Contentto a File

Figura 1.

3. Cliccare su Chip Erase ed attendere fino al termine dell’operazione (Figura 2).



4. Spuntare File Length, cliccare su “Write file to Flash” e selezionare il file .pcm nel PC, che

conterra I’intera traccia audio. Attendere il termine dell’operazione (Figura 2).

Open Help About

SRAM
PS2 & LED

~FLASH
~Random Access

Address : I[] wDATA I[]u IDATA |g[]

Chip Erase (40 Sec) | wite | Read |

Sequential Write
Address Iu Length: [3E4F6A (™ File Length

[ Write a File to FLASH

—Sequential Re
Address : Length : Ig [~ Entire Flash

Load FLASH Contentto a File

5. Assicurarsi di chiudere la connessione USB cliccando su Open - Close USB Port (Figura 3).

Open | Help About
Open USE Port 0
Close USB Port

~FLASH
—Random Access

Address : Iu wDATA Iug IDATA IUU

Chip Erase (40 Sec.) I Write I Read l

—Sequential Write

Address : Ig Length: |3E4F6A ¥ File Length

‘Write a File to FLASH

—Sequential Read

Address : Iu Length : Iu [~ Entire Flash

Load FLASH Contentto a File

Figura 3.



CARICAMENTO SOFTWARE.

Il software puo essere caricato su una ROM dell’fpga, oppure all’interno di una memoria volatile.
Nel primo caso una volta caricato il gioco questo rimane in maniera permanente all’interno della
board. 1l secondo caso €, invece, il piu rapido, ma all’interruzione dell’alimentazione, il software,
inserito da noi nella memoria volatile, verra perso e, al prossimo avvio della DE1 in modalita RUN,
verra presentato nuovamente il software dell’ Altera, precaricato nella ROM.

Forniamo ora i passaggi necessari per caricare il gioco nella board in entrambi i casi appena

discussi.

A. MODALITA VOLATILE: FILE .SOF

1. Assicurarsi che lo switch 12 sia su RUN (Figura 4).
2. Eseguire il tool di sviluppo Quartus
3. Click su File > Open Project e selezionare il progetto in formato .qpf (Figura 5)

Edit View Project Assignments Processing Tools W

File
L]  New... Ctrl+N i
& Open... Ctrl+0 E
Close Ctrl+F4 i Il
& New Project Wizard...
|5 OpenProject... Ctrl+3
Save Project
Close Project
=  Save Ctrl+S
Save As...
@ Save Al Ctrl+Shift+S

File Properties...

Figura 4. Figura 5.

4. Cliccare su Tools > Programmer e si aprira I’utility di traferimento (Figura sottostante).
rocessing | Tools I Window Help 5 8

anake Run Simulation Tool » B2 @ = » @ a 3
T ng %2  Launch Simulation Library Compiler

w P S > SR~ S S |



5. Selezionare il file del progetto, in questo caso snake.sof (Figura 6).

6. Assicurarsi che sia spuntato Program/Configure (Figura 6).

7. Assicurarsi che sia selezionata I’hardware corretto USB-Blaster in alto a sinistra altrimenti
selezionarlo dall’apposito menu sulla sinistra (Figura 6).

Attenzione: se in precedenza non & stata chiusa la connessione, questo non sara

selezionabile.
8. Assicurarsi che sia selezionata la modalita di trasferimento JTAG (Figura 6).
File Edit View Processing Tools Window Help ) |Search altera.com ‘@
L_»;‘;‘i.:}-ian':ﬁmare Selup |UsB-Blaster [iJSB-Oj 7 Mode: fJTiAwGi ¥ | Progress: [ ]

[] Enable real-time ISP to allow background programming (for MAX II and MAX V devices)

G File Device Checksum Usercode Program/ Verify Blank- Examine
Bt Start | Configure Check

<y snake.sof {EP2C20F484 00512747 00512747 [ ] il il |

| 3 Auto Detect |
=
|5 change Fie... |

1A save File

: 5 Add Device...
i up

ﬂ% Down

Figura 6.



9. Infine cliccare su Start a sinistra. A questo punto il progetto é in esecuzione.

B. MODALITA PERMANENTE: FILE .POF.

Assicurarsi che lo switch 12 sia impostato su PROG (Figura 4).

Eseguire il tool di sviluppo Quartus.

Click su File >Open Project e selezionare il progetto in formato .qpf
Cliccare su Tools - Programmer e si aprira ’utility di traferimento.

In MODE selezionare Active Serial Programming a dare conferma all’avviso.
Cliccare Add File a sinistra e selezione il corrispettivo file .pof.

Accertarsi che Program/Configure, Verify, Blank/Check siano spuntate.

G N o o & w DN P

Cliccare su Start ed attendere fino al completamento.

Per tutti i punti precedenti da 3 a 8 fare riferimento alla Figura 7 riportata nella pagina seguente.

9. Per eseguire infine I’intero progetto e visualizzarne gli output spostare lo switch 12 su RUN.

File Edit View Processing Tools Window Help = Search altera.com @
_; Hardware Setup... | |USB-Blaster [USB-0] Mode: |Active Serial Programming v Progress: [ ]
[] Enable real-ti allow background programming (for MAX II and MAX V devices)
G File Device Checksum Usercode Program/ Verify Blank- Examine
1 Start Configure Check
i Stop snake.pof\ EPCS4 059ESFE8 00000000 [ |
34 Auto Detect
X Delete

Y Add File
' Add File...

WL_“; Change File...

L@ Save File

8 Add Device
) Add Device, .,

Figura 7.
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CALIBRAZIONE SCHERMO.

In questo progetto e stata predisposta una semplice funzione per la calibrazione dello schermo che

permette di centrare opportunamente ’area di gioco mediante i comandi su monitor VGA.

La funzione ¢ attivabile mediante lo switch 8.

MODIFICA IMPOSTAZIONI LIVELLO.

Qualora si volessero cambiare i punteggi adibiti al Level-Up (punteggio associato ad ogni cambio
livello) lo si puo fare utilizzando la guida di seguito:

1. Aprire il progetto in Quartus.

2. Nella sezione Files, in Project Navigator, fare doppio click su game.v e scorrere fino alla

riga 1916. Saranno presenti delle condizioni: il numero dopo il “>=" rappresenta la soglia da

cambiare.

3. Cliccare su File = Save

4. Cliccare su Processing > Start Compilation

5. Rieseguire il procedimento per il caricamento software.

Per una migliore comprensione della procedura descritta si rimanda alla Figura 8 (pagina dopo).

File Edit View Project Assignments Processing Tools Window Help 2
DA xa@d snake MY LG D rg D R 9P A
Project Navigator BE x| Compilation Report - snake @ game.v &
Pl sy AN B RAGT EE A DKG 0S8 R S | > EEE
> |§| fifovga.qip 1013
Fr@ game.v! 1914 reg [15:0] level duration coefficient;
ollsnake.v 1915
?vga.v 1916 changes level depending on current score.
"ab ; 1917 always @ (posedge clock or posedge reset)
#d audio.v 1918 [Hbegin
‘,?Ea testbench_for_vgafb.v 1918 [H if (reset) begin
gﬂ leds.v 1920 current_ level<=3'd0;
E stpl.stp 1921 level duration coefficient<=1§'d2;
= 1922 end else begin
E] ram_fiing.stp 1923 =] if (currentscore >= 10000) gslsgbsl
| fruit_population.stp 1924 current_level<=3'd7;
. =] rnddk oll.qin Vv |11925 level duration coefficien 16'd2;
2 tierarchy E] Files 4 Design Units Jﬂ 1926 end else if (currentscore >= Z¥0 ) begin
1927 current_ level<=3'dé;
Tasks o®x||1928 level duration coefficient<=1&'d4;
) — | 1929 end else if (currentscore >= &000 ) begin
low: | Compilation v | | Customize... || 1939 current level<=3'd5;
= 1931 level duration coefficient<=1§'d3;
Task 1932 end else if (currentscore >= 4000 ) begin
Y4 4 P Compile Design 1933 current_level<=3'd4;
v 4 P Analysis & Synthesis 1934 level duration coefficient<=1§'d3;
Tol & fh Carisin 1935 end else if (currentscore >= 3000 ) begin

Figura 8.
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MODIFICA FRUTTA.

E possibile modificare a proprio piacimento anche i vari tipi di frutta inseriti nel gioco. Per farlo:

1. Aprire il progetto e portarsi nella sezione Flles come in precededenza
2. Aprire il file resources/graphics_roms/pieces_rom.mif.

Verra visualizzata una finestra come in figura sottostante.

File Edit View Project Assignments Processing Tools Window Help 3

DA @ % 2@ 9 o [meke -y e > &
|Project Navigator 15 x £ resources/graphics_roms/pieces_rom.mif [£3) & resou
Eﬂ hex7.v ~
Addr +0 +1 +2 43 +4 45 +6 +7 ASCII
2bd snake.sdc 5
% resources/graphics_roms/levels.mif 00 F F 8 F F F & 9

% resources/graphics_roms/currentscore.mif 08 9 F 9 9 3 g 5 9
éj resources/graphics_roms/elapsed.mif
% resources/graphics_roms/new_numbers.mif 10 9 9 9 9 F 9 9 9
L%] resources/graphics_roms/nextpiece.mif
# ;E__] resources/graphics_roms/pieces_rom.mif
|£] gameboard.gip 20 B F F B B F F F
=| piecesrom.gip
E] textromo.qip

18 F F F B |1 F F B

28 B B F F F F B B

- |=] textrom1l.aip i 30 F F F F 6 F F F
/4% Hi E] Fi g i i ve d
& Hierarchy ] Files B Desion Hois = |_’_I 8 F e |F |F. |F |6 |F |6 \
[Tasks e x|
G = 40 F ) 9 F 9 9 9 9
Flow: |Compilation ¥ | | Customize...
48 F 9 9 F 7 7 7 F
Task A

50 7 ¥ 7 7 74 1 1 1

4 4 P Compile Desian

3. Ogni frutto & composto da 25 caselle (in ordine orizzontale) nel .mif .
Ogni casella di questo file rappresenta una casella del frutto, come
mostrato nella figura a lato.

Modificando i numeri si andra a modificare il colore della casella nella

griglia del frutto, secondo la tavola dei colori sotto riport

ata.
TAVOLOZZA COLORI A4 BIT.
0 NERO 8 GRIGIO
1 MARRONE 9 ROSSO
2 VERDE 10 LIME
3 VERDE OLIVA 11 GIALLO
4 BLU SCURO 12 BLU
5 VIOLA 13 FUCHSIA
6 FOGLIA DI THE 14 TURCHESE
7 ARGENTO 15 BIANCO
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MODIFICA MAPPE.

Per la modifica delle mappe e di tutti i labirinti, conviene ricrearli con un editor di grafica come
Photoshop e riconvertirli opportunamente, come descritto nel file Relazione.pdf nel capitolo
dedicato al “GAMEBLOCK?”, reimportando infine il risultato in Quartus.

MODIFICA AUDIO.

Per modificare I’audio bisogna scegliere i file, convertirli opportunamente, concatenarli e
reimportarli in Quartus, seguendo i vincoli di formato descritti sempre nel capitolo “gameblock”

della Relazione citata in precedenza.

ISTRUZIONI DI GIOCO.

All’avvio del gioco sul monitor vengono visualizzati:
o il campo di gioco con eventuali labirinti

- losnake,

la frutta a comparsa casuale

un orologio che segna il tempo di gioco e che viene resettato ad ogni partita
il punteggio (CURRENT SCORE)

il prossimo frutto che comparira sul campo (NEXT PIECE)

Sulla DE1 sono presenti 4 display a 7 segmenti. Si sono utilizzati 2 di questi per visualizzare il
numero di frutti presenti sul campo, ed il livello attuale e in particolare quello di sinistra indica il

numero di frutti mentre quello d destra il livello.

Il giocatore puo scegliere di pilotare lo snake o con i push buttons o tramite la tastiera PS/2 con le
classiche freccette situate in basso a destra. Nel primo caso la seguente configurazione € la

seguente:

KEY3 2 SINISTRA
KEY2 2 GIU
KEY1 -2 SU

KEYO - DESTRA
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Il led verde, LEDGO, da un’informazione sulla periferica di comando attiva: se & spento allora
significa che si sta utilizzando la PS/2 , se invece € acceso si comanda con PUSH-BUTTONS.

La modalita e selezionabile mediante lo switch SWO:

- basso > PS/2

- alto - PUSH-BUTTONS

Sia gli effetti sonori (mangia/morte/cambia livello) che la musica di sottofondo sono disattivabili: i

primi mediante lo switch alto SW4, mentre la colonna sonora grazie allo switch alto, SW3.

E possibile mettere in pausa il gioco ponendo alti entrambi gli switch SW0 e SW1.
E stata inserita anche 1’opzione di reset che permette di iniziare una nuova partita in qualsiasi

momento alzando e abbassando, semplicemente, lo switch SW7.

Ad ogni frutto mangiato corrisponde un diverso punteggio: raggiunta una certa soglia di punti la
mappa del campo di gioco cambia architettura e contemporaneamente aumenta la velocita dello

snake. In questo modo la difficolta del gioco aumenta leggermente ad ogni nuovo livello.

Alla morte dello snake (muro o coda) la partita termina e si richiede I’input dell’utente tramite lo
switch SW7 per iniziarne un’altra.

Di seguito si riassumiamo con una tabella il comportamento degli switch e dei led.

SWO0 Basso: PS/2 LEDGO Acceso: utilizzo push buttons
Alto: push-buttons LEDG1 Acceso: pausa

SW1 | Alto: Pausa —solo in modalita push buttons LEDG2 -

SW2 - LEDG3 | Acceso: musica sottofondo in riproduzione

sw3 Alto: disattiva musica sottofondo LEDG4 Acceso: SFX attivati

sw4 Alto: disattiva effetti sonori (SFX) LEDG5 -

SW5 - LEDG6 -

SW6 - LEDG?7 Acceso: reset

SwW7 -

sSws Alto: Calibrazione schermo

SwW9 Alto-Basso: reset
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